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Quick Start 

Quick Start 

Quick Start helps you to understand the E5061B operation quickly. 

 Overview 

 Front Panel 

 Rear Panel 

 Screen Area 

 Three Methods of Operation 

 S-Parameter Measurement 

 Basic Measurement Procedures 

 Measurement Example of a Bandpass Filter 

 Impedance Measurement 

 Basic Measurement Procedure 

 Measurement Method 

 Measurement Example of a Capacitor (Port 1 Reflection)  

 Measurement Example of Crystal (Port 1-2 Series) 

 Measurement Example of a Capacitor (Port 1-2 Shunt) 

 Measurement Example of a Ceramic Resonator (Gain-
Phase/Series-Through) 

 Measurement Example of a Capacitor (Gain-Phase/Shunt-
Through) 
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Overview 

Front Panel: Names and Functions of Parts 

 
Ground Terminal 

Ground terminal is provided with the E5061B and is connected to the 
chassis of the E5061B. You can connect a banana-type plug to this 
terminal for grounding. 

Hardkeys 
ACTIVE CH/TRACE Block 

A group of keys for selecting active channels and traces. For more on the 
concepts of channels and traces, see Setting Channels and Traces. 

Hardkey 
Name 

Description 

Channel 
Next 

Selects the next channel as the active channel. (Each time the 
key is pressed, the active channel steps up from the current 
channel to the channel with one number larger than the current 
channel number). A channel must be active before you can 
define such parameters as the sweep range. To change the 
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settings of a channel, use this key to first make the channel 
active. 

Channel 
Prev 

Selects the previous channel as the active channel. (Each time 
the key is pressed,the active channel steps down from the 
current channel to the channel with one number smaller than 
the current channel number). 

Trace 
Next 

Selects the next trace as the active trace. (Each time the key is 
pressed, the active trace steps up from the current trace to the 
trace with one number larger than the current trace number). A 
trace must be active before you can define measurement 
parameters and other settings. To change the settings of a 
trace, use this key to first make the trace active. 

Trace 
Prev 

Selects the previous trace as the active trace. (Each time the 
key is pressed, active trace steps down from the current trace 
to the trace with one number smaller than the current trace 
number). 

ENTRY Block 

A group of keys used for entering numeric data is provided on the front 
panel of the E5061B. 

Hardkey 
Name 

Description 

0, 1,  2, 3 
..... 9 , . 
Keys 
(numeric 
keys) 

Type numeric characters or a decimal point at the position of 
the cursor in the data entry area. 

+/-  +/- alternately changes the sign (+, - ) of a numeric value in the 
data entry area. 

G/n, M/u, 
k/m,  x1  
  

Adds a prefix to the numeric data typed by using the numeric 
key and +/- key. One of the two prefixes written on the surface 
of the key is automatically selected depending on the parameter 
to be entered. x1 is entered without a prefix. 

Softkey 
On/Off , 
Entry Off 

Turns off the data entry bar if it is displayed. If the dialog box is 
displayed, it cancels the entry and closes the dialog box. If the 
data entry bar and dialog box are not displayed, it turns the 
softkey menu display on/off. 

Bk Sp Backspace key. 

Foc Changes the selection (focus) among the objects to be 
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manipulated by the NAVIGATION Block keys and ENTRY Block 
keys. The objects to be manipulated by the NAVIGATION Block 
keys and ENTRY Block keys include softkey menus, data entry 
areas, tables (e.g., segment tables, limit tables, and marker 
tables), and dialog boxes. When two or more of these objects 
are displayed on the screen and need selecting, use this key to 
change the selection (focus) among the objects to be 
manipulated. When a softkey menu is selected, the menu name 
area at the top of the menu is displayed in blue. When a data 
entry area is selected, the data entry bar is displayed in blue. 
When a table is selected, the frame of the table window is 
displayed in light gray. While a dialog box is displayed, the focus 
is fixed on the dialog box and cannot be changed. 

Help Displays help for E5061B. 
INSTR STATE Block 

A group of keys related to the macro function, store and call function, 
control/management function, and presetting of the E5061B (returning it 
to the preset state). 

Hardkey 
Name 

Description 

Macro Setup Displays the Macro Setup Menu in Softkey Menu Bar. 
Manipulating the Macro Setup Menu enables you to start 
up the VBA editor or to create, call, or store a VBA project. 

Macro Run Executes a VBA procedure called "main" that has a VBA 
module named Module1. 

Macro Break Stops the VBA procedure being executed. 

Save/Recall Displays the Save/Recall Menu in Softkey Menu Bar. 
Manipulating the Save/Recall Menu enables you to store 
the setup conditions to or read from the storage devices, 
calibration data, and trace data of the analyzer. 

Capture/System First, temporarily saves the data for the image displayed 
on the LCD screen the moment this key is pressed to the 
internal memory (clipboard). Immediately after that, 
displays the System Menu in Softkey Menu Bar. 
Manipulating the System Menu enables you to define the 
setup for the limit test and then execute it, or to define the 
setup for the control and management of the analyzer. 
Using the Dump Screen Image option enables you to store 
the image data in the clipboard to a file on the storage 
devices. Also, using the Print option in the System menu 
enables you to print the image data in the clipboard to a 
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printer. 

Preset Displays the Preset Menu in Softkey Menu Bar. Clicking OK 
in the Preset Menu enables you to return the analyzer to 
the initial setup state, called the preset setup. 

MKR/ANALYSIS Block 

A group of keys used for analyzing the measurement results by using the 
markers and etc. 

Hardkey 
Name 

Description 

Marker Displays the Marker Menu in Softkey Menu Bar. Manipulating the 
Marker Menu enables you to turn the markers on/off and move 
them by entering stimulus values. You can place up to 10 
markers on each trace. 

Marker 
Search 

Displays the Marker Search Menu in Softkey Menu Bar. 
Manipulating the Marker Search Menu enables you to move a 
marker to a specific point (maximum, minimum, peak, and a 
point with a target value) on a trace. You can also find the 
bandwidth parameters (up to six) and display them. 

Marker 
Fctn 

Displays the Marker Function Menu in Softkey Menu Bar. 
Manipulating the Marker Function Menu enables you to not only 
specify the marker sweep range and the coupling of markers on 
a channel but also to display statistics data on traces. 

Analysis Displays the Analysis Menu in Softkey Menu Bar. Manipulating 
the Analysis Menu enables you to use the analytical function of 
the fault location, the SRL, and each limit test. 

NAVIGATION Block (No Label on Front Panel) 

The keys and Rotary knob in the NAVIGATION Block are used to navigate 
between softkey menus, tables (limit table, segment table, etc.), or 
selected (highlighted) areas in a dialog box as well as to change a numeric 
value in the data entry area by stepping up or down. When selecting one of 
two or more objects (softkey menus, data entry areas, etc.) to manipulate 
with the NAVIGATION Block keys displayed on the screen, first press the 
Foc (Focus) key in the ENTRY Block to select the object to be manipulated 
(placing focus on the object) and then manipulate the NAVIGATION Block 
keys (knob) to move among selected (highlighted) objects or change 
numeric values. 

The following descriptions show how the NAVIGATION Block keys work both 
when the focus is on a softkey menu and when the focus is on the data 
entry area. For more on tables and dialog boxes manipulation, refer to the 
manipulation procedure for each of these functions. 
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 When the focus is on a softkey menu (softkey menu is 
selected) 

 When the focus is on the data entry area (data entry area is 
selected) 

RESPONSE Block 

A group of keys used mainly for setting up response measurements on the 
E5061B. 

Hardkey 
Name 

Description 

Channel 
Max 

Changes between normal and maximum display of the active 
channel window. In normal display, all of the defined channel 
windows (both active and non-active) are displayed in split 
views on the screen. In maximum display, only the active 
channel window is displayed over the entire area, with non-
active windows not displayed. To maximize the active channel, 
double-click the channel window frame. Measurements are also 
carried out on the non-active channels that are not displayed. 

Trace Max Changes between normal and maximum display of the active 
trace window. In normal display, all of the defined trace 
windows (both active and non-active) are displayed in split 
views on the screen. In maximum display, only the active trace 
is displayed over the entire channel window, with non-active 
traces not displayed. To maximize the trace, double-click 
anywhere in the channel window. Measurements are also carried 
out on the non-active traces that are not displayed. 

Meas 

  

Displays the Measurement Menu in Softkey Menu Bar. 
Manipulating the Measurement Menu enables you to specify the 
measurement parameters (types of S-parameters) for each 
trace. 

Format Displays the Format Menu in Softkey Menu Bar. Manipulating 
the Format Menu enables you to specify the data format (data 
transformation and graph formats) for each trace. 

Scale Displays the Scale Menu in Softkey Menu Bar. Manipulating the 
Scale Menu enables you to specify the scale for displaying a 
trace (magnitude per division, value of the reference line, etc.) 
for each trace. You can also specify the electrical delay and 
phase offset for each trace. 

Display Displays the Display Menu in Softkey Menu Bar. Manipulating 
the Display Menu enables you to specify the number of channels 
and the channel window array, the number and arrangement of 
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traces, the setup for data math, etc. 

Avg Displays the Average Menu in Softkey Menu Bar. Manipulating 
the Average Menu enables you to define the averaging, 
smoothing, and IF bandwidth. 

Cal Displays the Calibration Menu in Softkey Menu Bar. Manipulating 
the Calibration Menu enables you to turn the calibration and 
error correction on/off and change definitions for calibration 
kits. 

STIMULUS Block 

A group of keys for defining the stimulus values (signal sources and 
triggers). 

Hardkey 
Name 

Description 

Start Displays the data entry bar for specifying the start value of the 
sweep range in the upper part of the screen. (It also displays 
the Stimulus Menu for specifying the sweep range in Softkey 
Menu Bar.) 

Stop Displays the data entry bar for specifying the stop value of the 
sweep range in the upper part of the screen. (It also displays 
the Stimulus Menu in the same way as Start.) 

Center Displays the data entry bar for specifying the center value of the 
sweep range in the upper part of the screen. (It also displays 
the Stimulus Menu in the same way as Start.) 

Span Displays the data entry bar for specifying the span value of the 
sweep range in the upper part of the screen. (It also displays 
the Stimulus Menu in the same way as Start.) 

Sweep 
Setup 

Displays the Sweep Setup Menu in Softkey Menu Bar. 
Manipulating the Sweep Setup Menu enables you to specify the 
signal source power level, sweep time, number of points, sweep 
type, etc. 

Trigger Displays the Trigger Menu in Softkey Menu Bar. Manipulating 
the Trigger Menu enables you to specify the trigger mode and 
trigger source. You can specify the trigger mode for each 
channel. 

LCD Screen 

The E5061B is equipped with a 10.4-inch TFT color, touch-sensitive LCD 
screen for displaying traces, scales, settings, softkeys and other 
measurement related information. The touch screen LCD allows you to 
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manipulate softkeys by touching the LCD screen directly with a finger. For 
more on the LCD screen, see Screen Area: Names and Functions of Parts. 

 Do not press the surface of the LCD screen with a sharp 
object (e.g., nail, pen, or screwdriver). Pressing the surface 
with a sharp-pointed object will damage the LCD screen 
surface or cause the screen to fail. 

 Valid pixels are 99.998 % and more. Below 0.002 % of fixed 
points of black, blue, green or red are not regarded as failure. 

Probe Power 

The E5061B Option 3L5 comes with two ports that can be used to provide 
power to external probes. See the Data sheet for the voltage and 
maximum current.  

 Other E5061B options do not have probe power ports.  
Standby Switch 

This switch can turn on/off the E5061B. The color on the button shows the 
status as shown below: 

Indicator Color Description 

Green Normal power on status. 

Orange Standby status. 

Red Illegal power on status. 

To turn off the power of the E5061B, be sure to follow the steps described 
below: 

1. First, press this standby switch or send a shutdown command from 
the external controller to activate the shutdown process (the 
processing of software and hardware necessary to turn off the power 
supply). This will put the E5061B into the standby state. 

2. Next, if necessary, turn off power supply to the Power Cable 
Receptacle (to LINE) on the rear panel. 

 Under normal use, never directly interrupt the power 
supply to the power cable receptacle on the rear panel when the 
power supply is on. Always keep the Line Switch (Always ON) at 
(|). Never turn it off (O). 
 
If you directly interrupt the power supply to the power cable 
receptacle when the power supply is on, or turn off the Line 
Switch (Always ON), the shutdown process will not work. This 
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could damage the software and hardware of the E5061B and 
lead to device failure. 
 
Turning on the power supply after a faulty shutdown may cause 
the system to start up in a condition called "safe mode." If this 
occurs, first shut down the system to set it to the standby state 
and then turn on the power supply again to start up the system 
in normal mode. 

Test Ports 
Port 1 and Port 2 

Port 1 and Port 2 are for S-parameter measurement. Port 1 can apply DC 
Bias. While signals are being output from a test port, the yellow LED above 
the test port is lit. 

LF Out, R and T Ports 

LF Out, R and T Ports are for Gain-Phase measurement. LF Out is a source 
port and it can apply DC Bias on measurement signal. The R and T ports 
are receiver ports. The input impedance for R and T ports can be selected 
from 50 Ω or 1 MΩ. 

LF Out can be used for DC voltage source during S parameter 
measurement. 

 Only E5061B Option 3L5 has LF Out, R and T Ports. Other 
E5061B options do not have these ports. 

 Do not apply the exceeded DC voltage or current to the test 
port. 

 When you use the probe which has a pin on the connector, 
place the plastic ring to avoid connector from damage. 

The test ports comply with Installation Category I of IEC 61010-1. 

USB Ports 

Two USB (Universal Serial Bus) Ports are provided that can be used for 
connecting to ECal (Electronic Calibration) module, USB keyboard, USB 
mouse, USB memory or a printer. Connecting a designated ECal module to 
this port enables ECal measurements to be taken. Connecting a compatible 
printer to this port enables screen information on the E5061B to be 
printed. See Using USB for more detail. 
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Rear Panel: Names and Functions of Parts 

 24 Bit (Handler) I/O Port 

The terminal to which an automatic machine (handler) used on a 
production line is connected. See 24 Bit (Handler) I/O Port. 

Connector type: 36-pin Ribbon (Centronics) connector 

Certificate of Authenticity Label 

The label shows the licence information of the Windows Operating System 

Ethernet Port 

A terminal for connecting the E5061B to a LAN (Local Area Network). 
Connecting this instrument to a LAN enables you to access the hard disk 
drive of this instrument from an external PC or to control this instrument 
by using SICL-LAN or telnet. 

Specification Value 

Connector type 8-pin RJ-45 connector 

Base standard 10Base-T/100Base-TX/1000Base-T 

External Monitor Output Port (VIDEO) 

A terminal to which an external color monitor (display device) can be 
connected. By connecting a color monitor to this terminal, the same 
information shown on the LCD screen of the main body can be displayed 
on an external color monitor. 

Connector type: 15-pin VGA connector, female 

External Trigger (EXT TRIG) 
Input 

A connector to which external trigger signals are input. This connector 
detects the downward transition from the HIGH state in TTL signals as the 
trigger signal. To use this connector to generate a trigger, you must set 
the trigger source to the "external" side. The connector type is BNC, 
female. 

Output 

The External Trigger Output Port can output the pulse with the specified 
polarity and position either before or after the measurement of each point. 
The connector type is BNC, female. 

Parameter Typical Value Condition 

HIGH Level Output Voltage 5 V Iout=-50µA 
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LOW Level Output Voltage 0 V Iout=50µA 

 The External Trigger Output Port can safely handle a maximum 
output current of 50 mA. 

GPIB Port 

The connection of an external controller through General Purpose Interface 
Bus (GPIB) connector allows you to configure an automatic measurement 
system.   

This GPIB port is used only for controlling the E5061B from an external 
controller. Use USB/GPIB interface to control other devices from the 
E5061B. You cannot control other devices from the E5061B through this 
GPIB port. 

Hard Disk Drive (HDD) 

Built in hard disk drive.  

Reference Signal Ports (10MHz) 

The specification for the signals is specified in the data sheet. 
Input (REF IN) 

The reference signal input connector is used for phase-locking the 
measurement signal from the E5061B to the external frequency reference 
signal. Inputting reference signal to this connector improves the accuracy 
and frequency stability of the measurement signal from the E5061B. When 
the frequency reference signal is input to this connector, the measurement 
signal from the E5061B is automatically phase-locked to the reference 
signal. When an input signal is not present, the frequency reference signal 
inside the E5061B is automatically used. The ExtRef on the instrument 
status bar is displayed in blue when the system is phase-locked to the 
external reference signal and in gray when not phase-locked. 
 
When using Option 1E5 (high stability time base), connect this connector 
to the REF OVEN by using the BNC(m)-BNC(m) cable included with the 
option. 

Output (REF OUT) 

A connector for outputting the internal frequency reference signal from the 
E5061B. By connecting this output connector to the external reference 
signal input connector of another device, the device can be phase-locked to 
the internal reference signal of the E5061B and used under this condition. 

High Stability Frequency Reference Output (REF OVEN, OPT 1E5) 

When Option 1E5 (high stability time base) is installed, the reference 
signal is output from this connector. Connect this connector to the REF IN 
by using the BNC(m)-BNC(m) adapter included with the option. 
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Line Switch (Always ON) 

Always keep this switch on (|). 

 Do not use this switch to turn off (O) the mains. Doing so may 
cause the analyzer to fail. For more information, see the 
description of the Standby Switch. 

Power Cable Receptacle (to LINE) 

The receptacle (outlet) to which the power cable is connected. 

 To connect the device to a power source (outlet), use the 
supplied three-prong power cable with a ground conductor. The 
plug attached to the power cable (on the power outlet side or 
device side of the cable) serves as the disconnecting device 
(device that cuts off power supply) of the E5061B. When the 
power supply must be cut off to avoid such danger as electric 
shock, pull out the power cable plug (on the power outlet side 
or device side of the cable). For the procedure for turning off 
the main in normal use, see the description in Standby Switch. 

For more on the power supply, see the Installation Guide. 

Serial Number Plate 

The label showing the product number, serial number and the installed 
option number. The accessary and system rack options are not listed on 
this label. (CFGxxx or ATOxxx in the first line is Agilent Use Only.) 

Test Set I/F Port 

This interface is reserved and currently not available. 

USB Interface Port (USBTMC) 

Through this port, you can control the E5061B from external controllers. 
For more information on the measurement system using the USB port, see 
the USB Remote Control System. 

Specification Value 

Connector type Universal serial bus (USB), type B (4 contact 
positions), Female (jack) 

Compliance 
Standards 

USBTMC-USB488 and USB2.0 

USB Ports 

Four USB (Universal Serial Bus) ports are provided that can be used for 
connecting to ECal (Electronic Calibration) module, USB keyboard, USB 
mouse, USB memory or a printer. Connecting a designated ECal module to 
this port enables ECal measurements to be obtained. Connecting a 
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compatible printer to this port enables screen information on the E5061B 
to be printed. See Using USB for more detail. 
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Screen Area 
Screen Area: Names and Functions of Parts 

Click on the name or area for details of the 
topic.

  

 Menu Bar 

 Data Entry Bar 

 Softkey Menu Bar 

 Instrument Status Bar 

 Channel Window 

 Windows XP Status Bar - Windows XP Status Bar may or may not 
appear, depending on the Windows license. Under the same 
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condition, either Windows resize buttons or E5061B resize button will 
appear. For more information, refer to Windows License. 
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Channel Window 

Window for displaying the traces. Because a channel corresponds to a 
window, it is called a channel window. When the outer frame of a channel 
window is displayed in light gray, it shows that the channel is an active 
channel (the channel for which setup is being performed). In the following 
figure, Channel 1 (the upper window) is the active channel. To make a 
channel active, use Channel Next or Channel Prev. Clicking inside a channel 
window will also make the channel active. 

Channel 1 Window and Channel 2 Window describes different 
measurement parameters available in the channel measurement window. 
The measurement parameters described in the Channel 1 and 2 Window 
correspond to the same channel measurement window and are displayed in 
separate windows for ease of read. 

Channel 1 Window 

 
  

Channel 2 Window 



E5061B 

36 

 
Bandwidth Parameters 

Turning on the bandwidth search function displays the bandwidth 
parameters here. 

Channel Number 

Indicates the channel number. 
Channel Status Bar 

The status of each channel is displayed here. 

Averaging Status 

Displays the averaging factor and averaging count when averaging is 
turned on. 

n/m (displayed in blue) Averaging: ON 
(m: averaging factor; n: averaging count) 

(not displayed) Averaging: OFF 

Channel Measurement Status 

Displays the update status of traces on the channel. 

! 

  

Measurement in progress. When the sweep time exceeds 
1.5 seconds, ↑  is displayed at the point on the trace. 

# Invalid traces. The measurement conditions have changed, 
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but the traces on the channel currently displayed have not 
been updated to match the new conditions. 

(No 
display) 

The measurement has not been executed. 

Error Correction Status 

Displays the execution status of error correction on the channel. 

  

IF Bandwidth/CW Frequency 

Indicates the IF bandwidth when the sweep type is linear/log frequency or 
the CW frequency when the sweep type is power. 

Port Extension Status 

Shows whether the port extension and impedance port extension (Option 
005 only) or is turned ON or OFF. port extension and impedance port 
extension can be truned on both at the same time. 

PExt (displayed in blue) Port extension: ON 

ZExt (displayed in blue) Z port extension: ON 

(not displayed) Port extension: OFF 

Sweep Range 

Indicates the sweep range by using the start/stop or center/span. 
Channel Title Bar 

You can assign a title to each channel and have the title displayed on the 
bar. 

Data Format 

The data format of each trace is displayed here. 

See Also: Trace Parameter Display 
Graticule Labels 

Y-axis divisions in the rectangular display format. When traces in the 
rectangular display format are overlaid, the Y-axis divisions for the active 
trace are displayed. The value of the reference line (the division line 
between  and ) is entered numerically by opening the data entry bar 
using the keys:  Scale > Reference Value. You can change values of the 
reference line at one-division intervals by placing the mouse pointer in the 
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area of the graticule label (the pointer changes from   to ), moving 
the pointer vertically with the left mouse button pressed, and then 
releasing the button at the desired location. 

Marker Indicators 

Indicates the positions of markers on the stimulus axis. 
  

 

Active marker indicator 

 

Non-active marker indicator 

You can also move a marker to the desired position by placing the mouse 
pointer on the marker indicator or position of the marker itself (the pointer 

changes from  to ), moving the indicator vertically with the left 
mouse button pressed, and then releasing the button at the desired 
location. 

Marker Numbers 

Displayed marker number is listed. For the active marker (the one for 
which setup and analysis are being performed), > is displayed at the left of 

the marker number. For the reference marker,  is displayed instead of 
the marker number. 

Marker Response Values 

The marker response value for each marker (the measurement value at 
the marker point) is displayed here. Two (or three) response values are 
displayed for data in Smith chart or polar display format. 

Markers 

The markers used for reading values on a trace. Up to 10 markers can be 
displayed for each trace. 

 

Active marker (the one for which setup and analysis are being 
performed) 

 

Non-active marker 

Here, "n" denotes a marker number. For the reference marker, however, 
nothing is displayed at the location of n. Clicking the marker or one of the 
Marker Indicators makes the marker active. 
  

Marker Stimulus Values 
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The marker stimulus value for each marker (the frequency/power level at 
the marker point) is displayed here. 

Properties 

Displays the status of the obtained calibration coefficients on the channel. 
Reference Line Indicators 

The indicators that indicate the position of the reference line for the Y-axis 
scale in the rectangular display format. One indicator is to the right and 
the other is to the left of the scale ( and ). To enter a numeric value for 
the position of the reference line, open the data entry bar using the keys: 
Scale > Reference Position. You can also move the position of the reference 
line by placing the mouse pointer on either of the two reference line 

indicators (the pointer changes from  to .), moving the indicator 
vertically with the left mouse button kept pressed, and then releasing the 
button at the desired location (i.e., a drag-and-drop operation). 

Scale Settings 

The scale setting for each trace is displayed here. This example shows that 
"10.00dB/" corresponds to 10 dB per division. "Ref 0.000dB" shows that 
the value of the reference line is 0 dB. 

See Also: Trace Parameter Display 
Statistics Data 

Turning on the statistics data function displays statistics data here. 
Trace Name/Measurement Parameter 

The names of the traces, such as Tr1, on the channel and their 
measurement parameters are displayed here.   to the right of the trace 
name indicates the active trace (the trace for which setup is being 
performed). To make a trace active, use Trace Next or Trace Prev. Clicking 
the line where the trace name is placed (the mouse pointer changes from 

  to ) also makes a trace active. 

See Also: Trace Parameter Display 
Trace Number 

In the rectangular display format, the trace number is displayed in the 
same color as the trace at the right end of each trace. 

Trace Status Area 

The setup for each trace is displayed here. 

See Also: Trace Parameter Display 

Trace status display 

Classification Contents 
inside [ ] 

Meaning 
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Error correction RO Error correction: ON (OPEN (n) 
response calibration) 

RS Error correction: ON (SHORT (n) 
response calibration) 

RT Error correction: ON (THRU (n) 
response calibration) 

ER Error correction: ON (Enhanced 
response calibration) 

F1 Error correction: ON (1-port 
calibration ) 

F2 Error correction: ON (Full 2-port 
calibration) 

Zcor Error correction: ON Impedance 
Calibration 

Fixture Compensation (Opt 
005) 

Zcomp Fixture Compenation ON 

Turning on/off traces Nothing Data trace: ON, Memory trace: OFF 

  M Data trace: OFF, Memory trace: ON 

  D&M Data trace: ON, Memory trace: ON 

  off Data trace: OFF, Memory trace: OFF 

Performing data math D+M 
(D+M&M) 

Execution of Data+Mem math 

When a memory trace is 
ON, see the contents 
inside () 

D- M (D-
 M&M) 

Execution of Data- Mem math 

  D*M (D*M&M) Execution of Data*Mem math 

  D/M (D/M&M) Execution of Data/Mem math 

Electrical delay Del A numeric value other than 0 (zero) 
is specified as the electrical delay or 
phase offset. 

Smoothing Smo Smoothing: ON 

Gating Gat Gating: ON 

Fault location FL(RT) Fault location: ON, Reflection type: 
Round Trip 
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  FL(OW) Fault location: ON, Reflection type: 
One Way 

SRL SRL(xxxΩ) SRL: ON (xxx is average cable 
impedance value) 

Parameter conversion Zr Conversion: ON (Impedance: 
Reflection measurement) 

  Zt Conversion: ON (Impedance: 
Transmission measurement) 

  Ztsh Conversion: ON (Impedance: 
Transmission-Shunt measurement) 

  Yr Conversion: ON (Admittance: 
Reflection measurement) 

  Yt Conversion: ON (Admittance: 
Transmission measurement) 

  Ytsh Conversion: ON (Admittance: 
Transmission-Shunt measurement) 

  1/S Conversion: ON (Inverse S-
parameter) 

  Conj Conversion: ON (Conjugation) 

Reference Tracking PTrk Peak Track 

  FTrk Frequency Track 

Equation Editor Equ Equation Editor: ON 
  

Trace Parameter Display  

As mentioned above, measurement parameters are displayed at the upper-
left of the trace window. However, there is difference in parameter display 
for network measurement and impedance measurement. 

Network Measurement 

When network measurement is selected, for example, S11, the following 
parameters are displayed at the upper-left of the trace window: 

Trace 
number 

Measurement 
Parameter 

Format Scale/Div 
Reference 
value 

Impedance Measurement (Option 005) 
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When impedance measurement is selected, the measurement parameter 
and format is replaced with Z-parameter and measurement method. 
Hence, the following parameters are displayed: 

Trace 
number 

Impedance 
(Z)-
Parameter 

Method Scale/Div 
Reference 
value 

Y-Axis (Log) 

Regardless of the measurement parameter, when Log scale is selected at 
Y-Axis, the following parameters change. 

If Linear scale is selected: 

Scale/Div 
Reference 
value 

If Log scale is selected: 

Top 
xx.xxx 

Bottom 
xx.xxx 

Example 

Below are examples of several scenarios. 

Network Measurement (with Linear Y-Axis):  

 
Network Measurement (with Log Y-Axis): 

 
Z Measurement (with Linear Y-Axis): 

 
Z Measurement (with Log Y-Axis): 
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Data Entry Bar 

Used to enter numeric data into the E5061B. Press a hardkey or softkey to 
enter data, and the data entry bar will appear at the top of the screen. To 
assign a title to a channel window, an entry bar that allows you to enter 
letters and symbols by using the front panel keys or mouse is displayed. 

Data entry bar 

 
 To manipulate the data entry bar by using the front panel 
keys, the data entry bar must be selected as the object to 
manipulate (with the focus placed on it). When the focus is 
placed on the data entry bar, the entire bar is displayed in blue. 
Pressing or clicking Foc Key in the ENTRY Block enables you to 
move the focus to the desired object. 

Close Button 

Closes the data entry area (turns off the display). Use mouse to 
manipulate this button. 

Data Entry Area 

When the data entry bar is displayed for the first time, the current settings 
are displayed on it. You can change numeric values by typing from the 
keyboard or in the ENTRY block on the front panel. 

You can hide the frequency information in order to ensure its 
confidentiality or for other reasons. For detailed information, see Hiding 
Softkey's Frequency Information. 

Parameter Name 

Displays the name of the parameter for which data will be entered. 
Step Button (Small) 

Increases or decreases the numeric value in the data entry area in small 
steps. Use the mouse to manipulate this button. 

Step Button (Large) 

Increases or decreases the numeric value in the data entry area in large 
steps. Use the mouse to manipulate this button. 
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Instrument Status Bar 

The instrument status bar displays the status of the entire instrument. 

 
Date and Time 

Displays the date and time generated by the internal clock. The display 
format is as follows: 

YYYY-MM-DD HH:MM 

Where: 

YYYY: Year (AD) 
MM: Month 
DD: Day 
HH: MM: Time (0:00 to 23:59) 

 You can turn the date and time display on/off by: System > Misc 
Setup  > Clock Setup > Show Clock. 

Display Update OFF Indicator 

When information update display on the LCD screen is turned off, this 
indicator is displayed. 

DC Output Indicator 

Displays the output port (LF or P1[Port 1]) and status (ON or OFF) for DC 
output. 

External Reference Signal Phase Lock 

When the frequency reference signal is input to the Reference Signal Input 
(REF IN) on the rear panel and the measurement signal of the E5061B is 
phase-locked to the reference signal, ExtRef is displayed in blue. 

Value Description 

ExtRef (displayed in 
blue) 

Measurement signal is phase-locked to the external 
reference signal. 

ExtRef (displayed in Measurement signal is not phase-locked to the 
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gray) external reference signal. 

 Even when the High Stability Frequency Reference Output (REF 
OVEN) and Reference Signal Input (REF IN) are connected, 
phase-locking may not occur immediately after power-on in a 
low-temperature environment. (The "ExtRef" display remains 
gray, not blue.) In such a case, wait a few minutes until the 
instrument has warmed up and the "ExtRef" display turns blue. 

Instrument Message/Warning 

Displays instrument messages and warnings. Instrument messages are 
displayed in gray and warnings in red. 

Measurement Status 

Displays the measurement status of the E5061B. 

Value Description 

Setup Setup for measurement in progress 

Hold Measurement on hold (idling) 

Init Measurement being initialized 

Man The trigger source is set to "Manual" and waiting for trigger. 

Ext The trigger source is set to "External" and waiting for trigger. 

Bus The trigger source is set to "Bus" and waiting for trigger. 

Meas A measurement is in progress. 
Overload Protection Indicator 

Displays when the overload is detected. 
Port R Status 

Displays the current settings of input impedance and attenuator for Port R. 
Port T Status 

Displays the current settings of input impedance and attenuator for Port T. 
RF Output OFF Indicator 

When RF signal output is turned off, this indicator is displayed. 
Service Mode Indicator 

Indicates the service mode status. The service mode indicator is displayed 
when E5061B enters the following state. 

Value Description 

SVC 
(displayed 

The E5061B is in service mode, which is used for self-
diagnosis and repair of the E5061B or 8 term calibration 
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in blue) mode. Therefore, measurement performance will not be 
guaranteed according to the specifications. If, under normal 
use, the system remains in the service mode and does not 
return to normal operating mode, there is a possibility that 
the instrument is out of order. 

SVC 
(displayed 
in red) 

An abnormal condition has been detected inside the E5061B. 
The unit may be damaged. Notify the Customer Contact listed 
at the end of this manual or the distributor from whom the 
unit was purchased. 

S-Param Port AC Couple Indicator 

This indicator is displayed when the S-param port couple status is AC. 
VBA Status 

Displays the state of the execution of the VBA program in the E5061B. 

Value Description 

Run A VBA program is currently running. 

Stop A VBA program has stopped. 
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Menu Bar 

By using the mouse and keyboard to manipulate the menu bar, you can 
perform interface operations that are equivalent to those of the keys in the 
ACTIVE CH/TRACE Block, RESPONSE Block, STIMULUS Block, 
MKR/ANALYSIS Block, and INSTR STATE Block on the front panel of the 
E5061B. The menus on the menu bar correspond to the key blocks, and 
their submenus to the hardkeys inside the key blocks. 
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Softkey Menu Bar 

A group of keys on the screen called by the softkeys and menu bars. You 
can manipulate these keys by using the NAVIGATION Block keys on the 
front panel, the mouse, or the keyboard. You can perform manipulations 
by directly touching the screen with your finger instead of using a mouse. 

Softkey Menu Bar 
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  To manipulate a menu bar, it has to be selected as the object to 
manipulate (with the focus placed on it). When the focus is placed on a 
menu bar, the menu title area at the top is displayed in blue. Pressing 
or clicking on Foc Key in the ENTRY Block enables you to move the 
focus to the desired object. 

E5061B Option 005 

With E5061B Option 005, Impedance Analysis Menu under the Measurement 
menu is activated. Else, this button is grayed out or disabled.  

 
Selecting Impedance measurement, |Z| for an active trace changes: 

 Format menu display. The only available Format option is Expand 
Phase.   
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 Analysis menu display. The Equivalent Circuit button is enabled. Else, 

this button is grayed out or disabled.    

 
All Other E5061B Options Except for Option 3L5 

For all other E5061B options except for E5061B Option 3L5, limited buttons 
as available under the Measurement menu, as shown below. Other buttons 
such as Gain-Phase, Gain-Phase Setup, DC Monitor Setup and Impedance 
Analysis Menu are not available:  
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Highlighted Softkey 

Pressing  and Enter key on the front panel or pressing Enter key on the 
keyboard causes the highlighted (selected) softkey to be executed. You 
can change which softkey in the menu is highlighted by turning  or 

pressing on the front panel or by pressing on the keyboard. 

Pressing the  key on the front panel or the key on the keyboard brings 

up the upper level softkey menu, and pressing the  key on the front 
panel or the key on the keyboard brings up the lower level softkey 
menu. 

Scroll Arrow (Large) 

When the softkeys in a menu overflow the screen, use this key to enable 
you to scroll the menu page by page. Both upward and downward scroll 
arrows are available. Use the mouse to manipulate these buttons. 

Scroll Arrow (Small) 

Using this button, you can scroll the menu one softkey at a time. Both 
upward and downward scroll arrows are available. Use the mouse to 
manipulate these buttons. 

Scroll Bar 

When the softkeys in a menu overflow the screen, clicking on the blank 
part of the scroll bar enables you to scroll the softkey menu up or down. 

Scroll Box 
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You can scroll the softkey menu up or down by using the mouse to select 
and drag the scroll box (pressing the button on the object to be moved and 
then releasing the button at the desired location). The length and position 
of the scroll box indicate the length and position of the currently displayed 
part of the softkey menu relative to the entire menu. 

Selection Mark 

Shows which softkey function is currently selected. 
Softkeys 

These are the actual keys you would use to perform setup. A  displayed to 
the right of a softkey indicates that pressing that softkey displays the lower 
layer of softkeys. 

Softkey Menu Title 

The title of the softkey menu is displayed here. Double-clicking on this part 
of the menu bar displays the top layer of softkeys. 

Softkey Status Display 

Displays a softkey's setup status. 

You can hide the frequency information in order to ensure its 
confidentiality or for other reasons. See Hiding Softkey's Frequency 
Information. 
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Three Methods of Operation 

You can operate the E5061B using one of three operating methods: using 
keys on the front panel, using a mouse and keyboard, and using the touch 
screen. This section illustrates these three operating methods through the 
example in which the channel window layout is set to four-channel display 
as shown in the following figure. 

In the next section and those following it, a series of operations is 
expressed as follows: 

Display > Allocate Traces >   

Four-Trace Display 

 
Operating Method Using Keys 

1. Press the DISPLAY key in the RESPONSE Block. 
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2. Press or key to move the cursor to the Allocate Traces, then 

press Enter or ( )  key. 
 

 

3. Press or  key to move the cursor to , then 
press Enter key. 

Operation Method Using a Mouse 
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1. From the Response menu, press Display key. 
 

 
  

2. Click Allocate Traces. 

3. Click  

Operation Method Using the Touch Screen 

1. Press Display key after presetting the E5061B (Executing Preset key). 
 

 
2. Click/Press Allocate Traces. 

3. Click/Press any desired setting. 
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S-Parameter Measurement 

S-Parameter Measurement 

 Basic Measurement Procedure 

 Measurement Example of a Bandpass Filter  
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Basic Measurement Procedures 

This section describes the basic measurement procedure using the E5061B 
and presents an example of the transmission measurement of a bandpass 
filter, for better understanding of how to use the E5061B. 

Basic Measurement Flow 
1. Determining measurement conditions 

  Initializing Parameters 

 Select: 

 Measurement Parameter 

 Data format 

 Sweep Type and range 

 Power level 

 IF bandwidth 
2. Calibration 

  Select calibration kit 

 Make a calibration 
3. Connecting the Device Under Test (DUT) 

 Connect DUT 

 Adjust the scale 
4. Analyzing measurement results 

 Analysis using markers 
5. Outputting measurement results 

  Store measurement result into a file 
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Measurement Example of a Bandpass Filter 

This section describes how to measure the transmission characteristics of a 
947.5 MHz bandpass filter. The measurement conditions for this 
measurement example are those suitable for a 947.5 MHz bandpass filter. 
To measure another device under test (DUT), change the measurement 
conditions to suit the particular DUT. 

STEP 1. Determining Measurement Conditions 

1. Preset the E5061B.  
 
Preset > OK 
  

2. Set the S-parameter to S21. 
 
Meas > S21 

 When measuring the reverse transmission characteristics, 
set the S-parameter to S12. 

3. Set the data format to the log magnitude format 
 
Format > Log Mag 
  

4. Set the center frequency to the bandpass filter center frequency. 
Next, specify the span frequency, which is set to 200 MHz in this 
measurement example. 
 
Center > 9 > 4 > 7 > . > 5 > M/m  
Span > 2 > 0 > 0 > M/m 

 When entering the frequency unit using the keyboard, type 
"G" for GHz, "M" for MHz, and "k" for kHz. 

5. Specify the number of measurement points per sweep. The number 
of measurement points in this measurement example is set to 401. 
 
Sweep Setup > Points > 4 > 0 > 1 > x1 
  

6. Specify the power level of the signal source. The power level in this 
measurement example is set to -10 dBm. 
 
Sweep Setup > Power > +/- > 1 > 0 > x1 
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7. Specify the IF bandwidth of the receiver as necessary. In this 
measurement example, the IF bandwidth is set to 10 kHz because of 
the need to lower the noise floor. 
 
Avg > IF Bandwidth > 1 > 0 > k/m 

STEP 2. Calibration 

To turn the error correction ON, set the calibration type to the full 2-port 
calibration and measure the calibration data. 

For details about calibration, see Calibration. 

1. Select the calibration kit suitable for the measurement cable. In this 
measurement example, Calibration Kit 85032F is selected. 

Cal > Cal Kit > 85032F 

2. Set the calibration type to the full 2-port calibration using the test 
port 1 and 2. 

Cal > Calibrate > 2-Port Cal 

3. Connect the OPEN standard (included in the calibration kit) to the 
other end of the measurement cable that is connected to the test 
port 1 as shown in the following figure, and measure the open 
calibration data at the test port 1. After measuring the open 

calibration data, a checkmark  is displayed to the left of the Port 1 
Open menu. 

Cal > Calibrate > 2-Port Cal > Reflection > Port1 Open 

In the same way, measure the calibration data for the SHORT/LOAD 
standards at the test port 1. 

Connecting the OPEN/SHORT/LOAD standards 
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4. In the same way as described above, measure the calibration data 

for the OPEN/SHORT/LOAD standards at the test port 2. 

5. Connect the measurement cables as shown in the figure below, and 
measure the thru calibration. After measuring the thru calibration 

data, a checkmark is displayed to the left of the Port 1-2 Thru 
button. 

Cal > Calibrate > 2-Port Cal > Transmission > Port 1-2 Thru 

Making the through calibration 

 
6. Set the full 2-port calibration measurement to DONE. The calibration 

factor is calculated based on the calibration data acquired, and the 
error correction is turned ON. 
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Cal > Calibrate > 2-Port Cal > Done 

7. Select the type in which the data is to be saved before saving the 
calibration factor (calculated based on the calibration data). 

Save/Recall > Save Type > State & Cal 

8. Store the calibration file to the disk of the E5061B. The symbol "X" 
appearing in the operations below represent the assigned numbers to 
be used when the file is saved. 

Save/Recall > Save State > State 0X 

STEP 3. Connecting the Device Under Test (DUT) 

1. Connect to the DUT to the E5061B. (See the below figure) 
 
Connecting the DUT 
 

 
  

2. Set the appropriate scale by executing the auto scale. (See the below 
figure) 
 
Scale > Auto Scale 
 
You can also adjust the scale by entering arbitrary values in the 
Scale/Div button, Reference Position button, and Reference Value. 
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S21 trace after executing the auto scale 

 
STEP 4. Analyzing Measurement Results 

This section describes how to use the marker function to read out 
important parameters for the transmission measurement of the bandpass 
filter (insertion loss, -3 dB bandwidth). 

Measuring the Insertion Loss 

1. Display a marker. 

Marker > Marker 1 

2. Using one of the following methods to move the marker to the center 
frequency of the bandpass filter. 

 On the entry bar, press 9> 4 > 7 > . > 5 > M/m  

 Turn the rotary knob  on the front panel to set it to the center 
frequency (947.5 MHz). 

3. Read the marker value displayed as shown in the figure below. In 
this example, the response value denotes the insertion loss. 

Measuring an Insertion Loss 
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Measuring the -3 dB Bandwidth 

Using the marker bandwidth search function, the bandwidth, center 
frequency between two cutoff frequency points, Q value, and insertion loss 
are all read out. These parameters are described in the following table. 

 If the two cutoff frequency points are not found, all data items 
except the insertion loss revert to zero. 
  

Parameter Description 

BW (Bandwidth) Stimulus width between two cutoff 
frequency points (low and high) 

cent (Center Frequency) Center point between cutoff frequency 
points (low and high) 

low (Left-side Cutoff 
Frequency) 

The lower frequency of the two cutoff 
frequency points 

high (Right-side Cutoff The higher frequency of the two cutoff 
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Frequency) frequency points 

Q (Q Value) Q = cent/BW  

loss (Insertion Loss) The measured value of the active marker. 

1. Display a marker. 

Marker > Marker 1 

2. Using one of the following methods to move the marker to the center 
frequency of the bandpass filter. 

 On the entry bar, press 9 > 4 > 7 > . > 5 > M/m  

 Turn the rotary knob  on the front panel to set it to the center 
frequency (947.5 MHz). 

3. Specify the bandwidth definition value that defines the pass band of 
the filter. In this measurement example, it is set to -3 dB. 

Marker Search > Bandwidth Value > +/- > 3  > x 1 

4. Set the bandwidth search function ON. 

Marker Search > Bandwidth 

5. The bandwidth data items (BW, cent, low, high, Q, loss) is displayed. 
(See the following figure.) 

Measuring the -3 dB Bandwidth 

STEP 5. Outputting Measurement Results (Save) 

You can save not only the internal data but also the measurement results 
such as trace data and display screens to the disk. 

Saving the Trace Data(in CSV format) 

You can save the trace data to the disk of the E5061B in CSV file format 
(extension: .csv). Since the CSV-formatted data to be saved is a text file, 
you can analyze the data using Microsoft Excel. 

Follow the step below to save the trace data: 

Save/Recall > Save Trace Data 
Saving the Display Screen 

You can save the screen displayed on the E5061B to the disk of the 
E5061B in Windows bitmap file format (extension: .bmp) or Portable 
Network Graphics format (extension: .png). 

Follow the step below to save the display screen: 

System > Dump Screen Image 
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 The image on the LCD display memorized in the volatile 
memory (clipboard) (the image on the LCD display when the 
Capture/System key is pressed) is saved. 
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Impedance Measurement (Option 005) 

Impedance Measurement 

 Basic Measurement Procedure 

 Measurement Method 

 Measurement Example of a Capacitor (Port 1 Reflection) 

 Measurement Example of a Crystal (Port 1-2 Series) 

 Measurement Example of a Capacitor (Port 1-2 Shunt) 

 Measurement Example of a Ceramic Resonator (Gain-Phase/Series-
Through) 

 Measurement Example of a Capacitor (Gain-Phase/Shunt-Through) 
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Basic Measurement Procedure 

 Procedure for Port 1 Reflection 

 Procedure for Port 1-2 Shunt/Series and GP Shunt/Series 

Other topics about Impedance Measurement Quick Start 

Procedure for Port 1 Reflection 

The basic procedure for Port 1 Reflection method is shown in the flow chart 
below: 
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STEP 1:Preparation for measurement 

STEP 2: Setting measurement conditions 
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STEP 3: Calibration 

STEP 4: Connecting test fixture 

STEP 5: Setting electrical length 

STEP 6: Fixture compensation 

STEP 7: Connecting DUT to test fixture 

STEP 8: Measuring DUT  

STEP 9: Analyzing measurement results 

STEP 10: Measuring other DUTs 

Procedure for Port 1-2 Shunt/Series and GP Shunt/Series 

The basic procedure for Port 1-2 Shunt/Series and GP Shunt/Series 
method is shown in the flow chart below: 
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STEP 1:Preparation for measurement 

STEP 2: Setting measurement conditions 

STEP 3: Connecting test fixture 

STEP 4: Calibration 

STEP 5: Connecting DUT to test fixture 

STEP 6: Measuring DUT  
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STEP 7: Analyzing measurement results 

STEP 8: Measuring other DUTs 
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Measurement Method 

 Available Methods 

 Measurement DUT Impedance Range for Each Method 

 Configuration for Each Method 

Other topics about Impedance Measurement Quick Start 

Available Methods 

This section describes the impedance measurement method. Five methods 
shown in the following table can be used to make an impedance 
measurement. For the connection for each method, see Preparation for 
Measurement. 

When you select Impedance (Meas > Impedance Analysis Menu) as the 
Measurement type, the measurement method is made available (Meas > 
Impedance Analysis Menu >Method).   

The characteristics of the measurement method is as described in the 
following table: 

Method Port 1 (or 2) 
Reflection  

Port 1-2 
Series 

Port 1-2 
Shunt 

GP Series GP Shunt 

Measurement 
DUT 
Impedance 
Range 

Low to 
middle 
impedance 

Middle to 
high 
impedance 
in the high 
frequency 
range  

Not 
applicable 
to 
grounded 
DUTs 

Very low 
impedance 
in the high 
frequency 
range 

Middle to 
high 
impedance 
in the low 
frequency 
range 

Very low 
impedance 
in the low 
frequency 
range 

Formula Zdut = 50 x 
(1+S11)/(1-
S11) 

Zdut = 50 
x 2 x (1-
S21)/S21 

Zdut = 50 
x S21/(2 x 
(1-S21)) 

Zdut = 50 
x (1-
S21)/S21 

Zdut = 50 
x S21/(2 x 
(1-S21)) 

Measurement DUT Impedance Range for Each Method 

The following figures show the 10% accuracy range for each method.  You 
can select the appropriate method according to your DUT impedance. 

Ports 1 and 2 
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Conditions of 10 % measurement accuracy range 

The following table shows the condition where the 10% measurement 
accuracy range shown above is specified. 

Method 
Frequen
cy  

Calibration  IFBW 

Sourc
e 
Powe
r 

Note 

Port 1-2 
Series 

5 Hz to 
3 GHz 

  

Full 2-port 
calibration at 
measurement 
terminals of 
fixture 

or 

Full 2-port 
calibration + 
Open/Short/L

See the following table 

Measurem
ent 
Frequency 

IF BW 

< 200 Hz 
≤ (1/5 × 
Measurem
ent 

-20 
to 0 
dBm 
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oad fixture 
compensation 

Note 

Frequency) 
Hz 

≥ 200 Hz ≤ 40 Hz  
 

Port 1 
Reflecti
on 

Open/Short/L
oad 
calibration at 
7 mm 
terminal  of 
the 16201A. 

Calibration 
kit: 16195B 
or 85031B 

Port 1-2 
Shunt 

100 
kHz to 
3 GHz 

Full 2-port 
calibration at 
measurement 
terminals of 
fixture 

or 

Full 2-port 
calibration + 
Open/Short/L
oad fixture 
compensation 

Note 

10 Hz 
10 
dBm 

Measurem
ent error 
in the 
short 
calibration 
is 
 included. 
(10 pH 
residual 
inductance 
of short 
standard is 
included.)  

A ferrite 
core is 
required to 
measure 
DUTs with 
100 mΩ or 
below at 
≤100 KHz. 

  

Temperature Condition 

 23±5 °C at calibration 

 (calibration temperature) ±1 °C at measurement 
Gain-Phase Ports 
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Conditions of 10 % measurement accuracy range 

The following table shows the condition where the 10% measurement 
accuracy range shown above is specified. 

Meth
od 

Freque
ncy  

Calibration  
Recei
ver 
Setup 

IFBW 

Sour
ce 
Pow
er 

Note 

GP 
Serie
s 

5 Hz to 
30 MHz 

Open/Short
/Load 
calibration 
at 
measureme
nt terminals 
of fixture 

Fixture: 
16047E or 

Rch: 
Zin=5
0 Ω , 
Att=2
0 dB 

Tch: 
Zin=5
0 Ω , 
Att=2

See the following table 

Meas. 
Freque
ncy 

IF BW 

< 200 
Hz 

≤ (1/5 × 
Measure
ment 

-20 
to 0 
dBm 

Only with 
the 
response-
thru 
calibratio
n at the 
terminals 
of fixture, 
the 
measure
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16034E/G/H 

 
Load 
Standard: 
Agilent PN 
5012-8646 
(THT) or 
0699-2829 
(SMD) 

0 dB Frequenc
y) Hz 

≥ 200 
Hz ≤ 40 Hz  

 

ment 
accuracy 
may be 
degraded 
due to a 
parasitic 
capacitan
ce of 
receiver 
port at RF 
range 
(≥1 MHz) 

GP 
Shunt 

Open/Short
/Load 
calibration 
at 
measureme
nt terminals 
of fixture 

(Source=-
10 dBm at 
calibration) 

Note 

  

Rch: 
Zin=5
0 Ω , 
Att=2
0 dB 

Tch: 
Zin=5
0 Ω , 
Att=0 
dB 

See the following table 

Meas. 
Freque
ncy 

IF BW 

< 50 Hz 

≤ (1/5 × 
Measure
ment 
Frequenc
y) Hz 

≥50 Hz ≤ 40 Hz  
 

10 
dBm 

Measure
ment 
error in 
the short 
calibratio
n is 
 included 
(10 pH 
residual 
inductanc
e of short 
standard 
is 
included.)  

Maximum 
DUT 
impedanc
e is 5 Ω 
in this 
 condition 
in order 
to avoid a 
receiver 
saturatio
n 

Temperature Condition 

 23±5 °C at calibration 

 (calibration temperature) ±1 °C at measurement 

Configuration for Each Method 

The following figure shows the configuration for each method. 
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Measurement Example of a Capacitor (Port 1/Reflection) 

This section describes how to measure a Capacitor. In this example, apart 
from E5061B option 005, 16201A terminal adapter and 16196A test fixture 
are used. The measurement is performed with 10 pF capacitor, hence, to 
measure another device under test (DUT), change the measurement 
conditions to suit accordingly. Prior to the measurement, ensure that the 
16201A terminal adapter is connected to the E5061B network analyzer. See 
Connecting Terminal Adapter. 

STEP 1. Setting Measurement Conditions 

1. Preset the E5061B. 
 
Preset > OK 

2. Set the trace display settings. 
 
Display > Num of Traces > 2 
 
Display > Allocate Traces > x2 

3. Set the measurement port to S-Parameter. 
 
Meas > Measurement Port > S-Parameter 

4. Set the measurement method to Port 1 Reflection.  
 
Meas > Impedance Analysis Menu > Method > Port 1 Refl 

5. Set the measurement type of each trace. 
 
Select Trace 1 as the active trace.  Meas > Impedance Analysis Menu > 
|Z| 
 
Select Trace 2 as the active trace.  Meas > Impedance Analysis Menu > 
z 

6. Set the format of the measurement of each trace. 

Select Trace 1 as the active trace. Format > Exp Phase > OFF 

Select Trace 2 as the active trace. Format > Exp Phase > OFF 

7. Set the sweep setup power. 
 
Sweep Setup > Power > -10dBm  

8. Set the sweep type. 
 
Sweep Setup > Sweep Type > Log Freq  
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9. Set the frequency bandwidth. 
 
Avg > IF Bandwidth > 100 Hz  

STEP 2. Calibration 

Once the measurement condition is set, impedance calibration should be 
performed. The 16195B calibration kit is required to perform the calibration. 

1. Connect the E4991-60022 OPEN standard to the 16201A terminal 
adapter (which is connected to Port 1 of E5061B). 

Cal > Cal Kit > 16195B 

Cal > Calibrate > Impedance Calibration > Open 

Once the open calibration is completed, a checkmark  is displayed to the 
left of the Open menu. 

2. Remove the OPEN standard and connect the E4991-60021 SHORT 
standard to the terminal adapter. 

Cal > Calibrate > Impedance Calibration > Short 

Once the short calibration is completed, a checkmark  is displayed to the 
left of the Short menu. 

3. In the same way, measure the calibration data for LOAD standard and 
LOW LOSS C standard. Use 04287-60021 50  termination LOAD 
standard and 04287-60022 LOW LOSS Capacitor standard. 

Cal > Calibrate > Impedance Calibration > Load 

Cal > Calibrate > Impedance Calibration > Low-Loss C 

Once the calibrations are completed, a checkmark  is displayed to the 
left of the Load and Low-Loss C menu. 

4. Set the calibration to DONE to save the performed calibration. 

STEP 3. Fixture Compensation 

As 16196A test fixture is used in this measurement example, fixture 
compensation should be performed to reduce possible errors induced by 
the test fixture. Ensure that the insulator assembly used is appropriate 
with the DUT. Refer to 16196A Test Fixture Operation and Service Manual 
to learn more about the fixture. 

1. Connect the 16196A test fixture to the terminal adapter and set the 
electrical length: 

a. Turn the adapter's 7-mm connector in the counterclockwise 
direction when viewed from above and screw the connection 
sleeve in fully. 
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b. Align the text fixture with the adapter's mount post and 7-mm 
connector and set it gently in place. 

c. Turn the adapter's 7-mm connector counterclockwise, connecting 
the bottom of the test fixture with the connector. 

d. Cal > Fixture Compen > Fixture > 16196A 
2. Set the open state by using the open state supplied. 

a. Using the Tweezers, place the open plate on top of the insulator 
assembly. 

b. Set the open plate with the protruding surface down. 
c. Fit the cap in place with the mark toward the front, and turn it to 

the right until it is locked. 
d. Cal > Fixture Compen > Compensate > Open  

e. Once the open compensation is completed, a checkmark   is 
displayed to the left of the Open menu. 

3. Set the short state by using the open state supplied. 
a. Remove the cap. Remove the open plate used to measure the 

open compensation data. 
b. Place the short plate on the insulator assembly with tweezers. 

Place the rod-shaped protrusion of the short plate downward, and 
insert it into the DUT insertion hole. 

c. Fit the cap in place with the mark toward the front, and turn it to 
the right until it is locked. 

d. Cal > Fixture Compen > Compensate > Short 

e. Once the short calibration is completed, a checkmark   is 
displayed to the left of the Short menu. 

4. Set the compensation to DONE to save the performed fixture 
compensation. Now, the fixture compensation should be automatically 
turned ON (Cal > Fixture Compen > ON). 

STEP 4. Connecting Device Under Test (DUT) 

1. Remove the cap. 
2. Insert the DUT into the insulator hole with tweezers. Use a magnifying 

glass to check that the DUT is inserted deeply enough into the insulator 
hole for it to contact the bottom electrode. 

3. Fit the cap in place with the mark toward the front, and turn it to the 
right until it is locked. 

4. Set the log scale for Trace 1 

Select Trace 1 as the active trace.  Scale > Y-Axis > Log 

5. Set the appropriate scale for both traces by executing the auto scale.  
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Scale > Auto Scale All 

STEP 5. Analyzing Measurement Results 

This section describes how to use Equivalent Circuit function to analyze the 
measurement. 

1. Analysis > Equivalent Circuit > Select Circuit > D. 

2. Analysis > Equivalent Circuit > Calculate. The calculated equivalent 
circuit parameters are displayed in each box of R1, C1 and L1. 

3. Analysis > Equivalent Circuit > Simulate > ON. 

4. Analysis > Equivalent Circuit > Display > ON. 

Sample results as shown below: 

DUT: 10 pF capacitor 

 
DUT: 100 pF capacitor 



E5061B 

82 

 



Quick Start 

83 

 

Measurement Example of a Crystal (Port 1-2/Series-Through) 

This section describes how to measure the frequency characteristics of a 
crystal by using the Series-Through method on Ports 1 and 2. 

In this example, the following items are used. 

Description 
Product/Agilent Part 
Number 

Note 

Test Fixture User Fixture - 

Shorting 
device  

User Shorting device - 

Leaded Load 5012-8646 
50 Ω leaded resister. 
Furnished with E5061B 
option 720. 

DUT  Crystal - 

Cable and 
Adapter 

Cables and adapters for 
Type-N or 3.5 mm 

Connect your fixture to 
ports 1 and 2 of the 
E5061B 

To measure another device under test (DUT), change the measurement 
conditions to suit the particular DUT. 

STEP 1. Determining Measurement Conditions 

1. Preset the E5061B. 
 
Preset > OK 

2. Set the number of traces at two and display each trace in one 
frame.  
 
Display > Num of Traces > 2 
 

Display > Allocate Traces > x2   

3. Set the measurement port to S Parameter. 
 
Meas > Measurement Port > S-Parameter 

4. Set the method to Port 1-2/Series-Through configuration. 
 
Meas > Impedance Analysis Menu > Method > Port 1-2 Series 
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5. Set the measurement parameter at |Z| for the trace 1 and θ type of 
each trace. 
 
Select Trace 1 as the active trace.  Meas > Impedance Analysis Menu > |Z| 
 
Select Trace 2 as the active trace.  Meas > Impedance Analysis Menu > θz 

6. Specify the center and span frequencies to observe the frequency 
characteristic. In this example, the center is set at 32 MHz and span is 
set at 30 kHz 
 
Center > 3 > 2> M/μ 
Span > 3 > 0 >k/m 

 When entering the frequency unit using the keyboard, type 
"G" for GHz, "M" for MHz, and "k" for kHz. 

5. Set the power level at 0 dBm (224 mV @ 50 Ω). 
 
Sweep Setup > Power > 0  > x1 

6. Set the sweep type at Log. 
 
Sweep Setup > Sweep Type > Lin Freq  

7. Set the IF Bandwidth at 100 Hz.  
 
Avg > IF Bandwidth > 1 > 0 > 0  > x1 

STEP 2. Calibration 

1. Select the calibration kit for leaded 50 Ω. 
 
Cal > Cal Kit > Leaded 50ohm 

2. Connect the test fixture on the ports 1 and 2. 

3. Set the open state of the test fixture. 

4. Measure the calibration data for open. 
 
Cal > Calibrate > Impedance Calibration > Open 

5. Set the short state of the test fixture. 

6. Measure the calibration data for short. 
 
Short 

7. Set the load on the test fixture. 

8. Measure the calibration data for load. 
 
Load 
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9. Finalize the calibration measurement. The calibration factor is 
calculated based on the calibration data acquired, and the error 
correction is turned ON. Cor is displayed at the bottom of the 
channel window. 

10. Done 

STEP 3. Connecting the Device Under Test (DUT) 

1. Set the DUT on the fixture. 
 

 
2. Set the log scale for Trace 1. 

 
Select Trace 1 as the active trace.  Scale > Y-Axis > Log 

3. Set the appropriate scale for both traces by executing the auto scale.  
 
Scale > Auto Scale All 

STEP 4. Analyzing Measurement Results 

This section describes how to use the Equivalent circuit analysis. 
Reading the values of resonant points 

1. Display a marker. 

Marker > Marker 1 

2. Search the minimum point. 
 
Marker Search > Min 

Reading the values of anti-resonant points 

1. Display the second marker. 

Marker > Marker 2 

2. Search the maximum point. 
 
Marker Search > Max 



E5061B 

86 

Using Equivalent Circuit Analysis 

1. Select the Equivalent circuit model. 
 
Analysis > Equivalent Circuit > Select Circuit > E. 

2. Turn the Equivalent Circuit Display ON. 
 
Analysis > Equivalent Circuit > Display  

3. Calculate each parameter of the circuit model. 
 
Calculate. The calculated parameters are displayed in each box of R1, 
C1 and L1. 

4. You can simulate the frequency characteristics by using the 
approximate value obtained from the above calculation. 
 
Analysis > Equivalent Circuit > Simulate 

Measurement Result 
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Measurement Example of a Capacitor (Port 1-2/Shunt-Through) 

This section describes how to measure the frequency characteristics of a 
capacitor using the Series-Through method on ports 1 and 2.  

In this example, the following items are used. 

Description 
Product/Agilent Part 
Number 

Note 

Test Fixture with 
DUT (Capacitor) 

PC board user fixture - 

Test Fixture with 
Open or Short 

PC board user fixture - 

Calibration Kit  85033E 
Mechanical Calibration 
Kit, DC to 9 GHz, 3.5 
mm 

Cable and Adapter 
Cables and adapters for 
Type-N or 3.5 mm 

Connect your PC board 
to ports 1 and 2 of the 
E5061B 

To measure another device under test (DUT), change the measurement 
conditions to suit the particular DUT. 

STEP 1. Determining Measurement Conditions 

1. Preset the E5061B. 
 
Preset > OK 

2. Set the number of traces at two and display each trace in one 
frame.  
 
Display > Num of Traces > 2 
 

Display > Allocate Traces > x2   

3. Set the measurement port to Gain-Phase.  
 
Meas > Measurement Port > S-Parameter 

4. Set the method  to Port 1-2 Shunt-Through configuration. 
 
Meas > Impedance Analysis Menu > Method > Port 1-2 Shunt 
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5. Set the measurement parameter at |Z| for the trace 1 and θ type of 
each trace. 
 
Select Trace 1 as the active trace.  Meas > Impedance Analysis Menu 
> |Z| 
 
Select Trace 2 as the active trace.  Meas > Impedance Analysis Menu 
> θz 

6. Specify the center and span frequencies to observe the frequency 
characteristic. In this example, the start is set at 100 kHz and stop is 
set at 1 GHz 
 
Start > 1 > 0 > 0 > k/m  
Stop > 1 > G/n 

 When entering the frequency unit using the 
keyboard, type "G" for GHz, "M" for MHz, and "k" for kHz. 

5. Set the power level at 0 dBm (224 mV @ 50 Ω). 
 
Sweep Setup > Power > 0  > x1 

6. Set the sweep type at Log. 
 
Sweep Setup > Sweep Type > Log Freq  

7. Set the IF Bandwidth at 100 Hz.  
 
Avg > IF Bandwidth > 1 > 0 > 0  > x1 

STEP 2. Calibration 

1. Select the calibration kit for 85033E. 
 
Cal > Cal Kit > 85033E 

2. Connect the two 3.5 mm cables on both ports 1 and 2. 

3. Perform Full 2-Port Calibration at the end of each cables. 
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4. Connect the fixture with open (or short) between the cables. 

 
  

5. Perform Auto Port Extension. 

STEP 3. Connecting the Device Under Test (DUT) 

1. Connect the fixture with DUT between the cables instead of the 
fixture, with open (or short). 

 
2. Set the log scale for Trace 1. 

 
Select Trace 1 as the active trace.  Scale > Y-Axis > Log 

3. Set the appropriate scale for both traces by executing the auto scale.  
 
Scale > Auto Scale All 

STEP 4. Analyzing Measurement Results 

This section describes how to use the Equivalent circuit analysis. 
Using Equivalent Circuit Analysis 

1. Select the Equivalent circuit model. 
 
Analysis > Equivalent Circuit > Select Circuit > E. 
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2. Turn the Equivalent Circuit Display ON. 
 
Analysis > Equivalent Circuit > Display  

3. Calculate each parameter of the circuit model. 
 
Calculate. The calculated parameters are displayed in each box of R1, 
C1 and L1. 

4. You can simulate the frequency characteristics by using the 
approximate value obtained from the above calculation. 
 
Analysis > Equivalent Circuit > Simulate 

Measurement Result 
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Measurement Example of a Ceramic Resonator 
(Gain-Phase/Series-Through) 

This section describes how to measure the frequency characteristics of a 
ceramic resonator using the Series-Through method on Gain-Phase ports 
using Agilent test fixture. You can connect Agilent 4 terminal pair type 
fixture on the Gain-Phase ports. 

In this example, the following items are used. 

Description 
Product/Agilent Part 
Number 

Note 

Test Fixture Agilent 16047E - 

Shorting Bar 16047-00621 Furnished with the 16047E 

Leaded Load 5012-8646 
50 Ω leaded resister. Furnished 
with E5061B option 720. 

DUT  Ceramic resonator - 

To measure another device under test (DUT), change the measurement 
conditions to suit the particular DUT. 

STEP 1. Determining Measurement Conditions 

1. Preset the E5061B. 
 
Preset > OK 

2. Set the number of traces at two and display each trace in one 
frame.  
 
Display > Num of Traces > 2 
 

Display > Allocate Traces > x2   

3. Set the measurement port to Gain-Phase.  
 
Meas > Measurement Port > Gain-Phase 

4. Set the method to Series-Through configuration. 
 
Meas > Impedance Analysis Menu > Method > GP Series T 50Ω, R 1MΩ 

5. Set the measurement parameter at |Z| for the trace 1 and θ type of 
each trace. 
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Select Trace 1 as the active trace.  Meas > Impedance Analysis Menu 
> |Z| 
 
Select Trace 2 as the active trace.  Meas > Impedance Analysis Menu 
> θz 

6. Specify the center and span frequencies to observe the frequency 
characteristic. In this example, the center is set at 395 kHz and span 
is set at 40 kHz. 
 
Center > 3 > 9 > 5 > k/m  
Span > 4 > 0 > k/m 

 When entering the frequency unit using the 
keyboard, type "G" for GHz, "M" for MHz, and "k" for kHz. 

5. Set the power level at 0 dBm (224 mV @ 50 Ω). 
 
Sweep Setup > Power > 0  > x1 

6. Set the sweep type at Linear. 
 
Sweep Setup > Sweep Type > Lin Freq  

7. Set the IF bandwidth at AUTO. 
 
Avg > IF BW Auto .  

8. Set the IFBW auto limit at 100 Hz.  
 
Avg > IFBW Auto Limit > 1 > 0 > 0  > x1 

STEP 2. Calibration 

1. Select the calibration kit for leaded 50 Ω. 
 
Cal > Cal Kit > Leaded 50ohm 

2. Connect Agilent 16047E test fixture on the ports R, T and LF Out. 

3. Set the open state of the 16047E. 

 Fasten the electrode securing screws at the HIGH and LOW 
sides without the DUT attached 

4. Measure the calibration data for open. 
 
Cal > Calibrate > Impedance Calibration > Open 

5. Set the short bar on the 16047E. 
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 Loosen the electrode securing screws so that the shorting bar 
is caught in the electrodes. 

 Fasten the electrode securing screws. 

6. Measure the calibration data for short. 
 
Short 

7. Set the load on the 16047E. 

 Loosen the electrode securing screws so that the load (leaded 
register) device is caught in the electrodes. 

 Fasten the electrode securing screws. 

8. Measure the calibration data for load. 
 
Load 

9. Finalize the calibration measurement. The calibration factor is 
calculated based on the calibration data acquired, and the error 
correction is turned ON. Cor is displayed at the bottom of the 
channel window. 

Done 

STEP 3. Connecting the Device Under Test (DUT) 

1. Set the ceramic resonator on the 16047E.  

2. Set the log scale for Trace 1. 
 
Select Trace 1 as the active trace.  Scale > Y-Axis > Log 

3. Set the appropriate scale for both traces by executing the auto scale.  
 
Scale > Auto Scale All 

STEP 4. Analyzing Measurement Results 

This section describes how to use the marker function to read out the 
resonant point and the Equivalent circuit analysis. 

Reading the values of resonant points 

1. Display a marker. 

Marker > Marker 1 

2. Search the minimum point. 
 
Marker Search > Min 

Reading the values of anti-resonant points 

1. Display a second marker. 

Marker > Marker 2 
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2. Search the maximum point. 
 
Marker Search > Max 

Using Equivalent Circuit Analysis 

1. Select the Equivalent circuit model. 
 
Analysis > Equivalent Circuit > Select Circuit > E. 

2. Turn the Equivalent Circuit Display ON. 
 
Analysis > Equivalent Circuit > Display  

3. Calculate each parameter of the circuit model. 
 
Calculate. The calculated parameters are displayed in each box of R1, 
C1 and L1. 

4. You can simulate the frequency characteristics by using the 
approximate value obtained from the above calculation. 
 
Analysis > Equivalent Circuit > Simulate 

Measurement Result 
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Measurement Example of a Capacitor (Gain-Phase/Shunt-Through) 

This section describes how to measure the frequency characteristics of a 
capacitor by using the Shunt-Through method on Gain-Phase ports. 

In this example, the following items are used. 

Description 
Product/Agilent Part 
Number 

Note 

PC Board with 
DUT 

PC board user fixture - 

PC Board  PC board user fixture - 

Power Splitter 11617L  
DC to 2 GHz Power Splitter with 
BNC connector. 

DUT 
(Capacitor) 

Capacitor - 

Cable and 
Adapter 

Cables and adapters 
for BNC 

Connect your PC board to LF 
Out/T and R connector of the 
E5061B. 

To measure another device under test (DUT), change the measurement 
conditions to suit the particular DUT. 

STEP 1. Determining Measurement Conditions 

1. Preset the E5061B. 
 
Preset > OK 

2. Set the number of traces at two and display each trace in one 
frame.  
 
Display > Num of Traces > 4 
 

Display > Allocate Traces > x4   

3. Set the measurement port to Gain-Phase.  
 
Meas > Measurement Port > Gain-Phase 

4. Set the method to Shunt-Through configuration. 
 
Meas > Impedance Analysis Menu > Method > GP Shunt T 50Ω, R 50Ω 
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5. Set the measurement parameter at |Z| for the trace 1 and θ type for 
each trace. 
 
Select Trace 1 as the active trace.  Meas > Impedance Analysis Menu 
> |Z|. 
 
Select Trace 2 as the active trace, then click  θz. 
 
Select Trace 3 as the active trace, then click  Cs. 
 
Select Trace 4 as the active trace, then click  Rs. 

6. Specify the center and span frequencies to observe the frequency 
characteristic. In this example, the start is set at 5 Hz and stop is set 
at 30 MHz. 
 
Start >  5 > x1  
Stop > 3 > 0 > M/μ 

 When entering the frequency unit using the keyboard, type 
"G" for GHz, "M" for MHz, and "k" for kHz. 

5. Set the power level at -10 dBm (70.7 mV @ 50 Ω). 
 
Sweep Setup > Power > -  > 1  > 0  > x1 

6. Set the sweep type at Linear. 
 
Sweep Setup > Sweep Type > Log Freq  

7. Set the IF bandwidth at AUTO. 
 
Avg > IF BW Auto .  

8. Set the IFBW auto limit at 100 Hz.  
 
Avg > IFBW Auto Limit > 1 > 0 > 0  > x1 

STEP 2. Calibration 

1. Select the calibration kit for leaded 50 Ω. 
 
Cal > Cal Kit > Leaded 50ohm 
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2. Connect the through fixture on the ports R, T and LF Out as shown 
below. 

 
3. Measure the response calibration data. 

 
Cal > Calibrate > Response (Thru) > Thru  

4. Finalize the calibration measurement. The calibration factor is 
calculated based on the calibration data acquired, and the error 
correction is turned ON. Cor is displayed at the bottom of the 
channel window. 

Done 

STEP 3. Connecting the Device Under Test (DUT) 

1. Set the PC board with DUT.  

 
2. Set the log scale for Trace 1. 

 
Select Trace 1 as the active trace.  Scale > Y-Axis > Log 

3. Set the appropriate scale for both traces by executing the auto scale.  
 
Scale > Auto Scale All 
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STEP 4. Analyzing Measurement Results 

This section describes how to use the marker function to read out the 
resonant point and the Equivalent circuit analysis. 

Using Equivalent Circuit Analysis 

1. Select the Equivalent circuit model. 
 
Analysis > Equivalent Circuit > Select Circuit > D. 

2. Turn ON the Equivalent Circuit Display option. 
 
Analysis > Equivalent Circuit > Display  

3. Calculate each parameter of the circuit model. 
 
Calculate. The calculated parameters are displayed in each box of R1, 
C1 and L1. 

4. You can simulate the frequency characteristics by using the 
approximate value obtained from the above calculation. 
 
Analysis > Equivalent Circuit > Simulate 

 
 


